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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for Additional

5.0.35.1

Content Pack(s)

Step 1: Run Content Installer for Additional Content

Pack(s)

1. The Welcome dialog will open. Click Next.

=10l ]

' Welcome to the Bizlnsight Content

Installer  Content Pack Name Setup
Wizard

The Setup Wizard will install BizInsight Content Installer
BizInsightSunGardEAS on wour computer, Click Mext bo
continue or Cancel ko exit the Setup Wizard.

Back

Cancel |

2. Review the End User License Agreement and if you agree to the terms, check the |
accept the terms in the License Agreement checkbox and click Next.

& .

- =10l =]
End-User License Agreement

Flease read the following license agreement carefully

#9BizNetsoftware’

4

End User License Agreement

INOTICE TO ALL USERS: PLEASE READ THIS AGREEMENT
CAREFULLY. BY CLICKING THE ‘T AGREE™ BUTTON AT
THE BOTTOM OF THIS PAGE OR BY INSTALLING AND
USING THE SOFTWARE. YOU AGEEE TO ACCEPT ALL OF
THE TERMS AND CONDITIONS OF THIS AGREEMENT
AND YOU AGREE THAT THIS AGREEMENT IS

TATCAOADCTADIT AC TC TT ITATY DOTAT CT/AALTTY DV WATT 'I'ELI

¥ I accept the terms in the License Agreement

Print Badk I Mext I Cancel I
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3. Click on the desired Setup Type button.

i‘é’- BizInsight Content Installer SaSssias Setup ) =10lxl

Choose Setup Type

Choose the setup type that best suits your needs
#29BizNetsoftware’

Installs the most common program features. Recommended for most users.

Custom |

Allows users to choose which program features will be installed and where
they will be installed. Recommended for advanced users.

Complete |

All program features will be installed. Requires the most disk space.

Badk | et | Cancel

Custom setup type options that are available:

i‘é’- BizInsight Content Installer SaSs S Setup ) - =]

Custom Setup

Select the way you want features to be installed.
#7¢BizNetsoftware’

Click the icons in the tree below to change the way features will be installed.

peel= Ll cizInzight 1.0.0.0 Co
= ~ | Desktop Shortcut
i (=20 v | Program Menu Shortout

This feature requires 327ME on
your hard drive.

4 | |

Location: C:\Program Files (x86)\BizNet Software\BizNetERP B
1.0.0.0Y

Reset Disk Usage Back I Mext I Cancel |
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4. Click Install.
IE(

Ready to install BizInsight Content Installer o
#2¢BizNetsoftware’

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back I @ Install I Cancel

5. Click Yes to any User Account Control messages.

@ User Account Control [ |

F Do you want to allow the following program from an unknown
./ publisher to make changes to this computer?

Program name: - - -

Publisher: Unknown
File origin: Hard drive on this computer

j Show details Yes | No I

Change when these notifications appear

6. When the installer completes, an icon will exist on the desktop if you did not disable
the creation of shortcuts.

q @

BizInsight

- g W aa

7. Double-click the shortcut on the desktop to launch the content installer. If you chose
a Custom installation and disabled the creation of shortcuts, you must browse to the
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directory to which the content installer files were extracted and double-click the
BizNet Content Installer.exe. If you installed to the default directory location, that dir-
ectory can be found in C:\Program Files (x86)\BizNet Software.

8. The content installer will inspect the server and determine what elements already
exist and indicate their presence with a green check mark.

BizInsight Content Installer x|

Relevant Information

;
¥ Reporiing Server Found

M | Install St
et ' Reporting Server User Found

Inst2d Report Server 9 Scripts Have Not Been Run
Create Report Server User | 6 S 8 DataSet Content Not Found
Run Script Files | Q S 8 MetaData Content Not Found

Q S 8 Function Content Not Found
¥ Users Have Been Added by Admin Tool

MI ¥ Settings Need To Be Configured by Config Tool
Deploy MetaData Content |
Deploy Function Content |

Admin Tool |
Config Tool |

e 0

Sage 100 ProvideX customers will see the following:

BizInsight b an Content Installer x|

Relevant Information

| Automatic Install I

"' Reporting Server Found
[ Manual Install Stages "' Reporting Server User Found

& Link Servers Found

Create Report Server User | e s DataSet Content Not Found
Q st MetaData Content Not Found
Q S Function Content Not Found
"/ Users Have Been Added by Admin Tool

' Settings Need To Be Configured by Config Tool

Install Report Server |

Link Servers

Deploy DataSet Contert

Deploy MetaData Content

Deploy Function Content

Admin Tool

Config Tool

View Additional Files

Exit

BizNet Software, Inc 4| Page
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9. Click on the Relevant Information link in the upper right corner and make a note of
the Report Folder name:

= : .

Relevant Information

Asonatc s [ JRI=TEY
[ Manual install Stages  Config Path: \\SERVER2D08RCorfiqurationPath
Install Report S CA\Bizlnsight Share*Config
Create Repot Sen  agimin Path \\SERVER2008R2\ AdministrationPath
Run Script Fil CABizlnsight Share\Admin
Report Server Uil: htto//SERVER2008R2/Report Server
Deploy DataSet € Report Folder BizNtERP
Deploy MetaData !
Sql Server MetaData
Deploy Function C Database and Instance Name: SERVERZ008RZ

Admin Tool Packaged with Content Packager Version 1.4.0.0

Conrfig Too Copyto Clipboard |
= o

Note |If the Relevant Information dialog does not contain any information and
BizInsight is already installed, go to a workstation where BizInsight is installed. Open
Excel on the workstation, click on the Application Settings button on the Bizlnsight
ribbon and copy the values provided for the Configuration Path, the Administration
Path, the Default Reporting Services Server and the Default Reporting Services
Folder Name fields.

10. Click Automatic Install.

BizInsight © o waw Content Installer x|
Relevant Information
' Automatic Install ' R
"' Reporting Server Found
- Manual Tnetal Slages

' Reporting Server User Found

Inctal Report Server m Scripts Have Not Been Run
Create Report Server User Q S8 DataSet Content Not Found
Run Seript Fles 0 S MetaData Content Not Found

0 S8 Function Content Not Found
"' Users Have Been Added by Admin Tool

MI ' Settings Need To Be Configured by Config Tool
Deploy MetaData Contert
Deploy Function Content

Admin Tool
Config Tool

e o
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Content Pack(s)

11. The content installer will deploy the MetaData and function content. The path will

be automatically defaulted to the path last used. Click OK.

Pre Installation Question

Deploy Local Cortent
Please choose a directory location for the Corfiguration Path: |C \Bizlnsight Share"Config

This directery will become @ shared netwerk diectory after the installation process. I Overde Configuraiion Feth

|

Ok Cancel

12. The content installer will open the content deployment dialog

. Most paths will not

need to be changed. But you must check the following to make sure they are cor-

rect:

a.

Make sure the folder name is the folder name currently being used. If the

folder is not the same as shown in the Relevant Information dialog, change

that field to match the folder that is currently being used.

/. Content Deployment =] B3
Relevant Information

Config Path:

—Contert Location

grel
Direstory where you instalied the content |

\\SERVER2008R2\Confiquration Path
C:\BizInsight Share\Config

les (<BE)\BizMet Softw

Change the folder name if
it does not match the
information from the
Relevant Information

dialog

e

\A\SERVER2008R2\AdministrationPath
—Reporting Services Settings — C:\Bizlnsight Share’ Admin

http //SERVER2008R2/Report Server

BizNetERP

SERVERZ2008R2

Default Reporting Services Se

Format: *hitp:/iserverfreportserver

Default Reporting Services Eoldam Server MetaData

q
Database and Instance Name:

Deploymert Options .
’7 | Data Source Name: |

Sage 100 ProvideX customers, skip this step.

Full name of the foider on the reporting sei

=lol x|

Copy to Clipboard

Adjust the Server Name field if your accounting system database is on
another server. NOTE |The server name will default to the last server used.
This may not be the right server for the content pack being deployed.

Sage 100 ProvideX customers, skip this step.

Adjust the Database Name field to point to your accounting system database.
If your accounting software uses a system or control database, provide the
name of that database rather than a company database name. NOTE |The
database name will default to the last database used. This may not be the

right database for the content pack being deployed.

BizNet Software, Inc
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13.

14.
15.

16.

Sage 100 ProvideX customers, skip this step - you must use Windows authen-
tication.

Select the desired authentication method — Windows authentication or Prompt for
Credentials.

IMPORTANT [You must use the same authentication method as selected for other
content packs.

— Deployment Options ——— [ Datasource Configuration
Data Source Name:
™ Ovenwrite Datasounces I'.'EE:'
Server Name:
I Overwite Reports [SERVER2002

Database Name:

ID},'namics

™ Use Folders for Datasources f'& Uze Windows Authentication
( ™ Prompt For Credentials

I= | Preserve Folder Structure

Deploy Contert | Exit |

Click Deploy Content.

The content installer will display a status message to indicate that it is working.

Working, Please Be Patient

4

Once complete, the installer will display links to the Reporting Services sites. Click
OK to continue with the installation.

BizNet Software, Inc 7| Page
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17. The License Administration Tool will open. Unless you need to add new users, click
Exit.

License Administration Tool - SERVER2008R2\linda =10 x|

Administration Path

| ]

MNetwark share where your license file is stored.

Validate License |

.g F
o

18. The content installer window will display the results of the automatic install. Click
Close.

BizNet Software, Inc 8| Page
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5.0.35.1 Content Pack(s)

19. Click Exit to close the content installer.

BizInsight v Content Installer x|

Relevant Information

| Automatic Install I

' Reporting Server Found
—M | Install St

e " Reporting Server User Found
' Scripts Have Been Run

Create Report Server User | W S DataSet Content Found

Install Report Server |

Run Script Fles | W/ S MetaData Content Found

&/ 8 Function Content Found

" Users Have Been Added by Admin Tool

¥ Settings Have Been Configured by Config Tool

Deploy DataSet Cortert |

Deploy MetaData Contert |

Deploy Function Content |

Admin Tool |

Corfig Tool |

(= | al

—

20. Repeat the above steps for each content pack that needs to be installed.
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Step 2: Updating Client Workstations with new Con-
tent

Once all BizContent updates have been updated on the server, each client workstation install-
ation needs to be updated with the new content add-in files.

If BizInsight is being used in a Citrix/Terminal Services environment, see "Implementing
Additional BizInsight Content on a Citrix/Terminal Services Server" on the next page.

If BizInsight is installed on individual workstations, instruct all BizInsight users to click on the
Scan for Content button on the Bizlnsight ribbon in Excel to update their workstations with
the new content.

T B B X B Q B M

Bizlnsight Application  Data  Expression Offline Save Changes Scanfor Bizhet About
Explorer  Settings  Caches  Editor to Bizlnsight Conte%t.ﬂ.ssistant

BizInsight Reparting and Analytics

If the users report that the Scan for Content button is missing, they may not have the most
current Bizlnsight version. The Scan for Content button was added in version . BizNet Soft-
ware recommends downloading and installing the latest Bizlnsight version but if you must
use an older version, see "Manually Installing BizContent Add-ins" on page 13.

If your users report an error similar to the following when opening Excel again, see
"Resolving “.xll could not be found” errors" on page 25 for steps to resolve.
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Implementing Additional Bizlnsight Content on a Citrix/Terminal Ser-
vices Server

1. Copy all new BizContent add-in files (.dll, .dna and .xll) from the Configuration Path
to the local BizInsight directory. If you do not know the location of the Configuration
Path, launch the Content Installer on the server and click on the Relevant Information
link in the upper right of the dialog.

2. Browse to the reg5 subdirectory of the local Bizlnsight directory. Open the file
named "Excelxxxx_register_OnDemand.reg" with Notepad.

3. Copy the last Openn entry in this file and paste directly below. Increment the Openn
and change the name to the new BizContent .xll file name. Repeat for each new con-
tent .xll file until all are represented in the file. For example:

"OPEN"="/A \"BizInsightXL.Foundation\""

4. Save your changes to the file.

5. Browse to the reg5 subdirectory of the BizInsight directory and execute the "Register
BizIinsight for Excel xoox OnDemand.bat" file to make sure it runs without error.

6. Have each Bizinsight user execute the "Register Bizinsight for Excel xxxx OnDe-
mand.bat" to register the additional content for their login.

BizNet Software, Inc 11| Page
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Appendices
Manually Installing BizContent Add-ins ... ... ... 13
Resolving “.xll could not be found” errors ... 25
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Manually Installing BizContent Add-ins

If you are using a Bizinsight version that is older than, you will need to register the BizCon-
tent add-ins manually in Excel. BizNet Software recommends upgrading to the latest
BizInsight version but if that is not possible, perform the following steps:

1. Browse to the BizInsight shared directory and copy the content add-in files (.dll, .xII
and .dna) to the directory to which you installed the Bizinsight client. If you are using
separate config and admin folders, the client add-in files will be in the config folder.

BizInsight = X
o []
‘G(\_:}v | .+ O5(C:) = BizInsight ~ - l‘ilj I Search BizInsight ﬂ
COrganize *  Inclodeinlibrary = Sharewith = 3 5~ O "E}'
. bins
regs

| % BizNetERP I

| 7| BizhetERP.dna

[ BizMetERP. (I

[} ©Open a Suppart [ssue

G iterns

The remaining steps vary based on the Office version installed:

Office 2010/2013 steps
Excel 2007 steps
Excel 2003 steps

Excel 2010/2013

1. Click on File > Options.

BizNet Software, Inc 13| Page
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E- ri ) - - |
.i. Home Insert
= save

B save As

£ Open

jj Close
Info

Mew

Print

Save & Send

Help

| :] Options L; |
B Exit
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7. Click on Add-ins in the left pane and then click on Go at the bottom on the
right pane.

[
Excel Options 2x
General =1 .
gy View and manage Microsoft Office Add-ins.
Farmulas
Pracfing Adg-ins.
Save Mame - [ Location [Tipe [4]
Active Application Add-ins
Language Bizinsight C\Bislnsight\bing\adxloader,dll COM Add-in
P gizinsightXLFaundation CAWindowes\SysWOWE4\mscoree.dil Eucel Add-in
B ariamie Bl Inactive Application Add-ins
Analysis ToolPak ice\Officeld\Libran Analysis ANALYSIZXLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA o\ Ofticel 4\Librany Analysis\ATPVBAEN.KLAM  Excel Add-in
1 Custom XML Data [« \Microsoft Office\Officel 4OFFRHD.OLL  Document Inspector
Add-Ins Dote (MU C\.les\microsoft shared\Smart Tag\MOFLDLL  Adtion

Eura Currengy Toals

Trust Center Finandial Symbol (L)
Headers and Foaters
Hidden Rows and Columns

t Office\ Office14\Libran EUROTOOLXLAM  Excel Add-in
s\microsoft shared\Smart Tag\MOFLDLL  Adtion

B \Microsoft Office\Officel HOFFRHD.DLL  Document Inspector
£&]\Micresoft Offics\Officel .0FFRHD.OLL  Document Inspector

Hidden Worksheets A]\Microsoft Office\OMicel\OFFRHD.OLL  Document Inspectar
Invisible Content Chbf\Microsoft Office\Officel 4OFFRHD.DLL  Document Inspector
Microsoft Actions Pane 3 XML Expansion Pack
Solver Add-in Chce\OMicel 4'Libran\SOLVER\SOLVER XLAM  Excel Add-in

Document Related Add-ins

Disabled Application Add-ins

Ada.in: Bizinsight

Publisher: <Monex
[ Ho available
Location: C\Bizinsight\bin5'adxloader.dil

Deswription:  AddinModule

Manage: [Excel Add.ins = GO
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2. Inthe Add-ins dialog, click on the Browse button.

fradms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

Automation... |

3

—BizInsight¥L .Foundation

ProgID: BizInsightXL.Foundation

3. Browse to the directory to which you installed Bizinsight and select the .xll file
in that directory. Then click OK.

x
S : = =
0\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}

Organize *  New folder == o« (il @
= - )
IE—-I PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
:LJ e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in
Automation...

Il

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

4. Click OK.
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Excel 2007
1. Click on the Office button and then click on the Excel Options button.
e "'\__I d ~ ‘ﬂ_ =
1 Recent Documents
) e
1 BizProperySheetdlsx W=l
= Open 2 Balance Sheet.xit !
o 3 Balance Sheet.xls =
4 SetGlobalProperties.xlsx =
H zave
H Save As ¥
5 Print b
ﬁ Prepare #
_ﬁ Send v
Publish *
-,
j Close
1) Excel Options [ X Exit Excel
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2. Click on Add-ins in the left pane and then click on Go at the bottom on the
right pane.

[
Excel Options 2x
General =1 .
gy View and manage Microsoft Office Add-ins.
Farmulas
Pracfing Adg-ins.
Save Mame - [ Location [Tipe [4]
Active Application Add-ins
Language Bizinsight C\Bislnsight\bing\adxloader,dll COM Add-in
P gizinsightXLFaundation CAWindowes\SysWOWE4\mscoree.dil Eucel Add-in
B ariamie Bl Inactive Application Add-ins
Analysis ToolPak ice\Officeld\Libran Analysis ANALYSIZXLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA o\ Ofticel 4\Librany Analysis\ATPVBAEN.KLAM  Excel Add-in
1 Custom XML Data [« \Microsoft Office\Officel 4OFFRHD.OLL  Document Inspector
Add-Ins Dote (MU C\.les\microsoft shared\Smart Tag\MOFLDLL  Adtion

Eura Currengy Toals

Trust Center Finandial Symbol (L)
Headers and Foaters
Hidden Rows and Columns

t Office\ Office14\Libran EUROTOOLXLAM  Excel Add-in
s\microsoft shared\Smart Tag\MOFLDLL  Adtion

B \Microsoft Office\Officel HOFFRHD.DLL  Document Inspector
£&]\Micresoft Offics\Officel .0FFRHD.OLL  Document Inspector

Hidden Worksheets A]\Microsoft Office\OMicel\OFFRHD.OLL  Document Inspectar
Invisible Content Chbf\Microsoft Office\Officel 4OFFRHD.DLL  Document Inspector
Microsoft Actions Pane 3 XML Expansion Pack
Solver Add-in Chce\OMicel 4'Libran\SOLVER\SOLVER XLAM  Excel Add-in

Document Related Add-ins

Disabled Application Add-ins

Ada.in: Bizinsight

Publisher: <Monex
[ Ho available
Location: C\Bizinsight\bin5'adxloader.dil

Deswription:  AddinModule

Manage: [Excel Add.ins = GO
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3. Inthe Add-ins dialog, click on the Browse button.

fradms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

Automation... |

3

—BizInsight¥L .Foundation

ProgID: BizInsightXL.Foundation

4. Browse to the directory to which you installed BizInsight and select the .xll file
in that directory. Then click OK.

x
S : = =
0\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}

Organize *  New folder == o« (il @
= - )
IE—-I PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
:LJ e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in
Automation...

Il

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

5. Click OK.
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Excel 2003

1. Click on Tools > Add-Ins

B3 Microsoft Excel - Book2

5] Ble Edt Vew [nsert Formst | Iocls | Data  window  Heb
TRWER- NPV IR AV Rl ™’
B - 5~ ii Research. .. Ak+Click
% A B c ‘ﬁ) Error Checking. .. G
o 5 I Speech k
-!. 3 | Shared Workspace. ..
-E % Share Workbock. .
; &1 | Track Chaniges r
2 omipare and Merge Waorkbooks. .,
s a1
g T Protection k
10 Cpline Collsboration 3
| 11| Goal Seek...
i Scenarios. ..
13
14 | Formula Auditing ¥
|15 l Macra 3
16 |
17 ety [
18| 3 AutoCorrect Options.. .
% ngsFoniae...
M | Qptions. ..
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2. Inthe Add-ins dialog, click on the Browse button.

fradms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

Automation... |

3

—BizInsight¥L .Foundation

ProgID: BizInsightXL.Foundation

3. Browse to the directory to which you installed Bizinsight and select the .xll file
in that directory. Then click OK.

x
S : = =
0\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}

Organize *  New folder == o« (il @
= - )
IE—-I PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
:LJ e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in
Automation...

Il

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

4. Click OK.
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Resolving “.xll could not be found” errors

In some rare instances, the name of the content add-in file provided with an update may
change. When an add-in file name is changed, Scan for Content will properly remove that
add-in file but will not delete the pointer to it that resides within Excel and the following
error will occur:

Microsoft Office Excel @

‘cilusersYinda‘documents\BizContent'\BizMetERP. xl' could not be found. Check the spelling of the file name, and
verify that the file location is correct.

If you are trying to open the file from your list of most recently used files, make sure that the file has not been

renamed, moved, or deleted.

Perform the following steps to resolve the issue:

The remaining steps vary based on the Office version installed:

Office 2010/2013 steps
Excel 2007 steps
Excel 2003 steps

Excel 2010/2013

1. Click on File > Options.

BizNet Software, Inc 25| Page



BizInsight 5.0.35.1 Installing Additional Content Packs: Appendices

E- ri ) - - |
.i. Home Insert
= save

B save As

£ Open

jj Close
Info

Mew

Print

Save & Send

Help

| :] Options L; |
B Exit
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7. Click on Add-ins in the left pane and then click on Go at the bottom on the
right pane.

[
Excel Options 2x
General =1 .
gy View and manage Microsoft Office Add-ins.
Farmulas
Pracfing Adg-ins.
Save Mame - [ Location [Tipe [4]
Active Application Add-ins
Language Bizinsight C\Bislnsight\bing\adxloader,dll COM Add-in
P gizinsightXLFaundation CAWindowes\SysWOWE4\mscoree.dil Eucel Add-in
B ariamie Bl Inactive Application Add-ins
Analysis ToolPak ice\Officeld\Libran Analysis ANALYSIZXLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA o\ Ofticel 4\Librany Analysis\ATPVBAEN.KLAM  Excel Add-in
1 Custom XML Data [« \Microsoft Office\Officel 4OFFRHD.OLL  Document Inspector
Add-Ins Dote (MU C\.les\microsoft shared\Smart Tag\MOFLDLL  Adtion

Eura Currengy Toals

Trust Center Finandial Symbol (L)
Headers and Foaters
Hidden Rows and Columns

t Office\ Office14\Libran EUROTOOLXLAM  Excel Add-in
s\microsoft shared\Smart Tag\MOFLDLL  Adtion

B \Microsoft Office\Officel HOFFRHD.DLL  Document Inspector
£&]\Micresoft Offics\Officel .0FFRHD.OLL  Document Inspector

Hidden Worksheets A]\Microsoft Office\OMicel\OFFRHD.OLL  Document Inspectar
Invisible Content Chbf\Microsoft Office\Officel 4OFFRHD.DLL  Document Inspector
Microsoft Actions Pane 3 XML Expansion Pack
Solver Add-in Chce\OMicel 4'Libran\SOLVER\SOLVER XLAM  Excel Add-in

Document Related Add-ins

Disabled Application Add-ins

Ada.in: Bizinsight

Publisher: <Monex
[ Ho available
Location: C\Bizinsight\bin5'adxloader.dil

Deswription:  AddinModule

Manage: [Excel Add.ins = GO
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2. Inthe Add-ins dialog, click on the Browse button.

fradms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

Automation... |

3

—BizInsight¥L .Foundation

ProgID: BizInsightXL.Foundation

3. Browse to the directory to which you installed Bizinsight and select the .xll file
in that directory. Then click OK.

x
S : = =
0\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}

Organize *  New folder == o« (il @
= - )
IE—-I PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
:LJ e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in
Automation...

Il

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

4. Click OK.
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Excel 2007
1. Click on the Office button and then click on the Excel Options button.
e "'\__I d ~ ‘ﬂ_ =
1 Recent Documents
) e
1 BizProperySheetdlsx W=l
= Open 2 Balance Sheet.xit !
o 3 Balance Sheet.xls =
4 SetGlobalProperties.xlsx =
H zave
H Save As ¥
5 Print b
ﬁ Prepare #
_ﬁ Send v
Publish *
-,
j Close
1) Excel Options [ X Exit Excel
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2. Click on Add-ins in the left pane and then click on Go at the bottom on the
right pane.

[
Excel Options 2x
General =1 .
gy View and manage Microsoft Office Add-ins.
Farmulas
Pracfing Adg-ins.
Save Mame - [ Location [Tipe [4]
Active Application Add-ins
Language Bizinsight C\Bislnsight\bing\adxloader,dll COM Add-in
P gizinsightXLFaundation CAWindowes\SysWOWE4\mscoree.dil Eucel Add-in
B ariamie Bl Inactive Application Add-ins
Analysis ToolPak ice\Officeld\Libran Analysis ANALYSIZXLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA o\ Ofticel 4\Librany Analysis\ATPVBAEN.KLAM  Excel Add-in
1 Custom XML Data [« \Microsoft Office\Officel 4OFFRHD.OLL  Document Inspector
Add-Ins Dote (MU C\.les\microsoft shared\Smart Tag\MOFLDLL  Adtion

Eura Currengy Toals

Trust Center Finandial Symbol (L)
Headers and Foaters
Hidden Rows and Columns

t Office\ Office14\Libran EUROTOOLXLAM  Excel Add-in
s\microsoft shared\Smart Tag\MOFLDLL  Adtion

B \Microsoft Office\Officel HOFFRHD.DLL  Document Inspector
£&]\Micresoft Offics\Officel .0FFRHD.OLL  Document Inspector

Hidden Worksheets A]\Microsoft Office\OMicel\OFFRHD.OLL  Document Inspectar
Invisible Content Chbf\Microsoft Office\Officel 4OFFRHD.DLL  Document Inspector
Microsoft Actions Pane 3 XML Expansion Pack
Solver Add-in Chce\OMicel 4'Libran\SOLVER\SOLVER XLAM  Excel Add-in

Document Related Add-ins

Disabled Application Add-ins

Ada.in: Bizinsight

Publisher: <Monex
[ Ho available
Location: C\Bizinsight\bin5'adxloader.dil

Deswription:  AddinModule

Manage: [Excel Add.ins = GO
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3. Inthe Add-ins dialog, click on the Browse button.

fradms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

Automation... |

3

—BizInsight¥L .Foundation

ProgID: BizInsightXL.Foundation

4. Browse to the directory to which you installed BizInsight and select the .xll file
in that directory. Then click OK.

x
S : = =
0\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}

Organize *  New folder == o« (il @
= - )
IE—-I PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
:LJ e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in
Automation...

Il

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

5. Click OK.
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Excel 2003

1. Click on Tools > Add-Ins

B3 Microsoft Excel - Book2

5] Ble Edt Vew [nsert Formst | Iocls | Data  window  Heb
TRWER- NPV IR AV Rl ™’
B - 5~ ii Research. .. Ak+Click
% A B c ‘ﬁ) Error Checking. .. G
o 5 I Speech k
-!. 3 | Shared Workspace. ..
-E % Share Workbock. .
; &1 | Track Chaniges r
2 omipare and Merge Waorkbooks. .,
s a1
g T Protection k
10 Cpline Collsboration 3
| 11| Goal Seek...
i Scenarios. ..
13
14 | Formula Auditing ¥
|15 l Macra 3
16 |
17 ety [
18| 3 AutoCorrect Options.. .
% ngsFoniae...
M | Qptions. ..
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2. Inthe Add-ins dialog, click on the Browse button.

fradms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

Automation... |

3

—BizInsight¥L .Foundation

ProgID: BizInsightXL.Foundation

3. Browse to the directory to which you installed Bizinsight and select the .xll file
in that directory. Then click OK.

x
S : = =
0\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}

Organize *  New folder == o« (il @
= - )
IE—-I PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
:LJ e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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The Add-ins dialog should now look like the following:

add-1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in

=
[

Automation...

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

4. Click OK.

9. Once in the add-ins dialog, uncheck the add-in mentioned in the error message. You
should get the following message. Click Yes. If you do not get this message, you
have unchecked the wrong add-in. Re-check it and uncheck the next one that is

shown that has a similar name.
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(Add-Ins e=)

Add-Ins avalable:

|| Anatysis ToolPak - oK

|| Analysis ToolPak - VBA

|w'] BizinsightXL. Foundation
Cmﬁtuud Sum Wizard

|| Internet Assistant VBA Bra

oI
W ]
|| Sohver add-n
Microsoft Office Excel [=3e]
'ﬂ Cannot find add-n "C:\BizMet Software \BizInsighi off. Dedete from list?
[ ves | [ Mo

10. Close and reopen Excel to confirm that the error no longer occurs.
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